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【1】 How to start
Switch on the main switch.①～④

（If the Ar laser is required）
Switch on the power supply and turn the key.⑤ ⑥

Wait about 5 minutes.
Set the switch to “run”. Wait about 30 seconds.⑦
（after the green LED lights）Adjust  the power control knob. ⑧
(Position to 9 o’clock)That the red LED is not lit.

Turn on the reflected light power supply.⑨
（When the display is flashing, the light does not go out.）

Start the PC.⑩ (Wait about 3 minutes.)
log in the ”LSM User”.
Double-click the “ZEN” icon.
Click the “Start System” button。

①

②
sideways

③

④

⑤

⑥
sideways

⑦ after 5 min ,
switch to the “run”

⑧
position to 9 o’clock
(That the red LED
is not lit)

⑩

⑨

Control area of the machine

When you click on the bar, items are displayed.
Can be separated by dragging the bar.
This area has many operations manual.

The microscope operation in Locate button.
The LSM operation in Acquisition button.
Button for scanning is arranged below the main tab.
Two columns in the Acquisition tool group.
Left column optical path setting.
Right column scan settings.
Additional configuration(experiment setting) is 
added to the lower side of the right column.

Image window and view control area
Display switching button is disposed on the left side. View controller are arranged on the lower side.
Tool will change the display state. Tool is divided by a tab.

Image area
! Mark has not been saved yet.
View image by double-clicking.
Put a star on the good image.

Main window
Window size changes
(Workspace zoom)

【2】 How to turn on the laser
Click the “Acquisition” button on the main tab.
Click the “Laser” bar. Turn on the necessary laser.
(There is no control in the argon and diode.)

Diode 405…for example,DAPI,Hoechst
Ar 458,488,514…for example,FITC,Axela488,GFP,CFP,YFP
DPSS 561…for example,Rhodamine,Cy3,Alexa568
HeNe594…for example Alexa594
HeNe 633… for example,Cy5,Alexa633

There are two ways Page 2. Please choose one or the other.
“Setting loading method”(Line Sequential) or “Smart setup method”(Frame Sequential)

for imaging for analysis

Main tab

Action tab

Tool group

View Tab

View controller

Image window

Thumbnail

【Confirmation】
Did you set the Ar power?

LSM780 Simple manual [for 2D imaging]
Correct me if i'm wrong
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＜ Setting loading method （Experiment Manager）＞
【3】 Optical path setting of laser microscope

Click the “Acquisition” button on the main tab.

Click on the OPEN icon that is located to the right of 
the Experiment Manager.
Select a setting from the list.

（When using differential interference image）
Click the “Light Path”bar.Click the Track button.
（Do not chosen DAPI,Hoechst track.）

Put a check in the T-PMT check box.
Correctly set the condenser of the microscope.

【4】 Viewed under a microscope
Click the “Locate” button on the main tab.

Click the Dye button.
DAPI…for blue dye(band path)
GFP…for green dye(band path)
DsRed… for red dye(band path)
AF488… for green dye(long path)
Transmit…bright field
DIC…differential interference 

Choose a lens with an icon of the objective lens.
（When change to a different type of lens, microscope to pause. 
After put the oil, press the “Done” button on the touch panel.）

【5】 Take the pictures with LSM
Click the “Acquisition” button on the main tab.

Click the “Channels” bar.
Click the “1AU” button of long wavelength side.

Click the “Set Exposure” button on the action tab.

Click the “Live” button.
After adjusting the focus, adjust the contrast(Digital Offset) 
and brightness(Gain(Master)).
Adjust the other tracks by clicking on the name of Channels.

Click the Stop After adjusting.

Differential interference setting
x10～x20 … Ⅱ
x40 , x63w , x63oil … Ⅲ

When you press the center button of the joystick
switch the fine / course of XY.

Laser power

brightness

contrast

Display switching

Lower the gain so as not to break the ChS.

Convenient to use the Split 
and Range indicator.

Caution!!
AU value does not change the objective lense after the change.

Configuration listing

Differential interference
contrast adjustment
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＜ Dye selection method (Smart setup)＞
【3】 Optical path setting of laser microscope

Click the “Acquisition” button on the main tab.

Click the “Smart Setup” button below the Experiment Manager.
Click the pull-down of Dye, choose a dye from Dyes list.
To register all the dyes being used.

Select the “Best Signal” and click the “Apply” button. 

（When using differential interference image）
Click the “Light Path”bar.Click the Track button.
（Do not chosen DAPI,Hoechst track.）

Put a check in the T-PMT check box.
Correctly set the condenser of the microscope.

【4】 Viewed under a microscope
Click the “Locate” button on the main tab.

Click the Dye button.
DAPI…for blue dye(band path)
GFP…for green dye(band path)
DsRed… for red dye(band path)
AF488… for green dye(long path)
Transmit…bright field
DIC…differential interference 

Choose a lens with an icon of the objective lens.
（When change to a different type of lens, microscope to pause. 
After put the oil, press the “Done” button on the touch panel.）

【5】 Take the pictures with LSM
Click the “Acquisition” button on the main tab.

Click the “Channels” bar.
Click the “1AU” button of long wavelength side.
（Other channels please match the optical slice.）

Check to any one the Tracks.
Click the “Set Exposure” button on the action tab.

Click the “Live” button.
After adjusting the focus, adjust the contrast(Digital Offset) 
and brightness(Gain(Master)).
Click the Stop After adjusting.

Check to other any one the Tracks. 
Click on the name of Channels.
Click the “Live” button. Adjust the contrast and brightness.
Click the Stop After adjusting. 

When the adjustment of all tracks is finished, 
check to all tracks.

Range changes 
when you change the position 
and length of the bar.

Differential interference setting
x10～x20 … Ⅱ
x40 , x63w , x63oil … Ⅲ

Lower the gain so as not to break the ChS.

Convenient to use the Split 
and Range indicator.

Laser power

Brightness

Contrast

Display switching

Select any one
to adjust.

Caution!!
AU value does not change the objective lense after the change.

When you press the center button of the joystick
switch the fine / course of XY.

Differential interference
contrast adjustment
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(If you would like to enlarge the image) 
Click the “Crop” button 
on the lower side of the image.
Move the frame to the desired location.
Click the “Snap” button on the action tab.

Click the “Acquisition Mode ” bar.
Change to 4 Number of Averaging.
Click the “Snap” button.

【6】 Save the image
＜Save a dedicated format. (Conditions remain)＞

Choose “Save as” from the File menu.
Choose the czi format. 
Specify the location and name.

＜ Save a generic format. (Conditions does not remain) ＞
Choose “Export” from the File menu.
Choose the file format. (Select “TIF” usually.)

Choose the data format. (Select “Contents of image window single plane”)

Click the “Select file name and save” button and
save the data.

Click the “Acquisition Mode ” bar. 
Change to 4 Number of Averaging. 
Click the “Reset All” button of the “Scan Area” field.
Repeated from 【4 】 to look for the next target.

【7】 Commonly used functions and tools
The left side of the image window
2D…Display of merging or single color.
Split…Display on a separate color.
Info…Display conditions.

The bottom of the image window
Dimensions tab…Change of color

Part of channel name…Change to visible , invisible. 
Part of color…Change the color.
Single Channel… Change to merging , single color.
Range Indicator…Display to confirm the saturation.

Reuse…Apply settings when you get the picture.
Display tab…Change the Brightness,Contrast.
Graphics tab…Writing of scale and annotation

I want to put the scale.→Click the scale icon and drag in the image.
I want to show the length.→Click the any graphic tool and write in image.

Check to “M” in the list.
I want to cut the part. →Click the any graphic tool and write in image.

Click the “Cut region” button.
Object is written, you can load and save.

Raw Data = For analysis
Contents of image window = Screen snapshot
Full resolution image window = To snap shots while 
holding the original resolution.
single plane = Output current data
series = Output all stack data

A bug has been found in LSM5 format saving.
If you need LSM5 format, save czi format just in case.

Evaluation is attached to 
the thumbnail.
（Correspondence only CZI format）
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【8】 How to finish
Click the “Acquisition” button on the main tab.
Click the Laser bar. Turn off the all laser.

Close the ZEN software.
Shutdown the windows.

Power off in reverse order.
Switch off the reflected light power supply.⑨

The position of the minimum power control knob. ⑧
Set the switch to “Idle”. ⑦
Turn to the key length. ⑥

（Start the cooling. Wait about 5 minutes until the fans stop.）

Do the cleaning of the objective lens.
Use the touch panel. Touch in order.
Microscope-Control-Objective
When you have finished cleaning, choose x10 lens.

（After the fan has stopped）Turn off the Ar laser power. ⑤

Turn off the main switch.④→③→②→①

Introduction of other functions
Z-Stack…Get serial section image and re-build.
Time Series…Time lapse scanning.
Bleaching…Bleaching the part of sample by high power laser.
Tile Scan…By connecting the image, obtain wide range high-resolution images.
Positions…Store the coordinates. To use for the auto scan or move.
Regions…Scan a specific area.
Lambda scan…Fluorescence spectroscopy. Separate the close wavelength dyes.
HDR…High dynamic range imaging.

These function work in complex.
Example… Z＋Time＝4D Imaging , Time＋Positions＝Multi point time lapes , Time＋Bleach＋Regions＝FRAP

FCS(fluorescence correlation spectroscopy) Please contact ZEISS when using.

Do you need a viewer?
Offers the viewer of three in our laboratory.
Choose a match for your PC. (Support Windows XP or later. Windows 8 is unconfirmed.)
Zen2009…for all PC. Old version. CZI format not supported.
Zen2012x86…for 32bit PC. 3D not supported. Support LSM5 format but not for LSM.
Zen2012x64…for 64bit PC. Same as the LSM system. We recommend.
Zen 2.3 or later…Not recommended due to many problems.

①

②
Lengthwise

③

④

After the fan has stopped

⑤

⑥
Lengthwise 
(wait about 5 min)

⑦

⑧
position to 7 o’clock

⑨

Reverse order
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Use the 2D imaging manual, get the image. 
This manual is the operation of 2D imaging later.

Check the “Z-Stack” in the multidimensional tool area.

Click the “Z-Stack” bar. Click the “Live” button.
Go to the start position by changing the focus. Click the “Set First” button. 
Go to the end position by changing the focus. Click the “Set Last” button.
Click the “Stop” button.
Click the number buttons on the Smallest item.
(Scan number is set automatically.)

Set Averaging Number and click the “Start Experiment” button.
Save the image at LSM5 format.

Additional functions of the stack image
The left side of the image window

Gallery…Tile display 
Ortho…Cross-section view
Cut…Arbitrary cut view
3D…Re-build stereoimage

The bottom of the image window
Dimensions…Changing the image by moving the Z-Slice Bar.
Player… Change the image automatically. 

The bottom of the image window（additional right tab）
If you select 3D, re-build tool is added.
When you drag an image and can change the angle. 
(To return to the initial position when you click the house icon.)

3D…Display method
Transparent…Display in consideration of the transparency.（Internal hardly appears）
Maximum…Built with information of the maximum intensity.（Internal structure is visible）
Shadow,Surface,Mixed…Not use.

Appearance…Detailed configuration
Transparency…When increase the transparency, during the visible.
Surface…Surface setting（not use）
Background…Background color setting (Maximum = black , Transparent = gray)
Light…Surface lightness
Special…Color-coded in depth information

Series…Animation setting
Render series…Setting the rotation axis
Total frames…Setting the number of frames
Difference angle…Interval (Panorama = Go round)
First angle…0°= Position that is currently displayed

Create a rotating image when you click “Apply” button.

When use to export, you can create a video file.

Making projection image
Display the original image.
Click the “Processing” button on the main tab.
Select “Maximum Intensity Projection”. Click “Select” button. Click “Apply” button.

Note the previous
value remain.

Clicking after setting

Cover glass side is First.

LSM780 Simple manual [for 3D imaging]
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Check the 2D imaging manual for basic operation.

Tile Scan…This is the function to get the big picture by connecting.
＜Setting for tile scan＞

Check the “Tile Scan” in the multidimensional tool area.
Click the “Tile Scan” bar. 
Set the number you want to include with the horizontal and vertical item.
（Current position is center.）

For a successful connection, to create an overlap.
Usually,set to 10%.

Online Stitching item performs Stitch process automatically, when scanning is completed.

However, it does not return to its original state before treatment.

Start tiling when the “Start Experiment” button is clicked.
Performs Stitch process , when scanning is completed.

Display stack image.Click the “processing” button on the main tab.
Select “Stitch” item.Click the “Select” → “Strict” → “Apply” button.

(With the Bounding grid, you can set the range simply by specifying the required place.)

Positions…Register the coordinates and let scanned automatically.
Can be used simultaneously with other functions.
＜Setting for Positions＞

Check the “Positions” in the multidimensional tool area.
Click the snap button , take a picture.
Click the “Positions” button on the lower side of the image.
Click the image , register the coordinates.
(You can also use the image of Tile scan for registration.)
Coordinates that are registered will be at the center.
Click the “Positions” bar. You can check the registration information.
If you want to add the coordinates and repeat the operation.
If you want to move to coordinate registration, select the coordinates, and click the "Move to" button.
If you want to remove the coordinates, select the coordinates, and click the “Remove” button.
Shoot automatically to the location where you registered when the “Start Experiment” button is clicked.

When you switch to sample career tab, you will be able to register the coordinates like a plate.

Click the Property button, set the interval and the number of wells.
Set the plate on the stage. Move position to A1 well.
Click the “Calibrate” button. Click on the A1 position in plate image.
(Linked the image and plate.)
When click on the other position in plate image,move to there.
Click the “Select” button. Click on the shooting location in plate image.
The chosen location will change to blue.
Shoot automatically to the location where you registered
when the “Start Experiment” button is clicked.

convenient to use for moving.

Plate Columns Rows Distance
6well 3 2 40
12well 4 3 27
24well 6 4 19.5
48well 8 6 13
96well 12 8 9

LSM780 Simple manual [for motorized stage]
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Check the 2D imaging manual for basic operation.

Click the “Acquisition” button on the main tab.

Click on the OPEN icon
that is located to the right of the Experiment Manager.
Select a “Lambda ***” from the list. (*** is excitation wavelength.)

Click the “Light Path” bar. Set the Resolution and Range.
(Usually, the range should be set to the excitation wavelength or longer.)
(Usually, resolution using 8.7nm.)

＜Take a picture＞
Get the image in order to avoid saturation.
(If you want to use multiple lasers, take the balance at laser power.)

＜Image windows area＞
2D…Display only one. Select the dimension tab when you want to display another.
Lambda Coded…Display in false color.
Gallery…Gallery view.
Unmixing…Separate the colors that mix. When you have selected this function, a new tab is added.

Unmixing…Configuration for separating the color. Choose a location to be reference.
＜Automatic recognition methods＞

Click the “Auto find / ACE” button.
Enter the number of the dye in the “Number Components” frame.
(Location is automatically selected.)

＜Manual recognition methods＞
Select a location using the ROI tool.
Choose the location to look to monochromatic.

Click the “Linear Unmixing” button when you select a location.
(New image that separates the color is created.)

[Other method]
You can use it to save the data of reference from a sample of single staining.

Extract…Create a band-pass image.
Bands…The number of colors you want to create.
Intensity…Calculation method. Select any one.

Sum (note the saturation) , Mean
Automatic (automatically adjusts the intensity)

Set the wavelength range.
Create new image when click the “extract” button.

If the range set to from 410 to 690 nm and 
the resolution set 8.7 nm,image of 32 ch is taken.

wavelength range

select color

LSM780 Simple manual [for Lambda scan]
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＜Linear Unmixing with Offline＞
Displays images acquired in lambda mode.
Click the Processing tab.
Select Linear unmixing in method menu.
Click Select button in method parameters menu.
Enter the number of fluorescent dyes in the Components field.
Click the pseudo color button under the Components field.
Select the reference spectrum and color that you saved in advance.
Click the Apply button. Dyes are separated.

＜Online Fingerprinting Mode＞
This mode performs Linear unmixing in real time based on previously acquired reference spectrum.

Open the Light path menu.
Click the Online Fingerprinting button.
Make the optical path setting the same as when acquiring the reference spectrum.
Pull down the "dye" field. Select the reference data. 
Acquire images in normal usage.
※Master gain will change the sensitivity of all channel. Balance with digital gain.
You have to adjust so as not to saturate.
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LSM780 Simple manual [Other functions]
Check the 2D imaging manual for basic operation. This function is used in addition to 2D imaging.

'Time series' is Time lapse function. 
This function can also be used simultaneously with Z stack or position.
＜Setting for Time series＞

Check the ‘Time series’ in tool area.
Open the ‘Time series’ bar.
Make the following settings.

Cycle…Number of image to capture Interval…Interval
If the interval is shorter than the scan time, it will be continuous scan.
You can enter a marker by clicking the setting button during scanning.
Click the Start Experiment button in tool area to start time lapse.

Regions is a laser irradiation area designation This function is used for bleaching and scanning.
＜Setting for Regions＞

Take an image for area designation.
Check the ‘Regions’ in tool area.
Open the ‘Regions’ bar.
Use draw tools to enclose arbitrary places. (Max 99 objects)
Select the check according to purpose of use.

Specified area scan…Check on the ‘Acquisition’.
Click the ‘Snap’ button to scan the specified area.

Bleaching…Check the ‘Bleach’ and ‘Analysis’.
Continue to set up bleaching.

＜Setting for Bleaching＞
Check the ‘Bleaching’ in tool area. (‘Time series’ and ‘Regions’ are also automatically checked.)
Open the ‘Bleaching’ bar.
Check the ‘Start Bleaching after # scans’. Specify timing to perform bleaching.
If you repeat the bleach, check the ‘Repeat Bleach after # scans’.
Specify the number of laser irradiation in the ‘Iterations’ field.
<Important> Check the ‘Safe bleach for GaAsP’.
Set the laser and power to be irradiated in ‘Excitation of Bleach’ item.
Continue to set up ‘Time series’. 
After setting, click the ‘Start Experiment’ button in tool area to start bleaching.
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HDR (High Dynamic Range) is a technique for fitting bright and dark parts into one frame.
＜Setting for HDR＞

Open the ‘Acquisition Mode’ bar. Check the ‘HDR’.
Adjust sensitivity so that images do not saturate.
Set ‘Frames’ and ‘Intensity’. Click ‘Snap’ to take HDR image.
(If you increase the number of frames,
you can shoot those with luminance differences.)

Use the ‘Photon counting mode’ when you want to shoot with a weaker laser power.
Image quality is inferior to normal mode. Scan slowly with weak laser power.
※Ch 1 does not correspond to Photon Counting Mode.

＜Setting for Photon Counting Mode＞
Open the ‘Channels’ bar. Click the ‘Photon Counting’ button.
Change the laser power to 0.2 and shoot.
Adjust image quality in the following way.

Changing Scan Speed will change the brightness
and image quality. (Slow scan is better)
When still dark, increase the laser power and digital gain.
ChS may be more beautiful than ch2.

Smart Setup is a function that sets the optimal optical path by choosing a fluorescent dye.
＜Other proposal at smart setup＞

Fastest…Simultaneous excitation (occur crosstalk)
Best Signal…Frame sequential (Recommend)
Best Compromise…When wavelengths are sufficiently separated, 

they are excited simultaneously.
Unmixing…Separate the fluorescence by calculation.

※Excitation wavelength may change with combination of fluorescence.

The LSM 780 can freely set the fluorescence wavelength.
＜How to change fluorescence wavelength＞

Click the track you want to change in the Light Path window.
Click the channel you want to change.
You can change the wavelength range by changing the length and position of the bar.
When Dye is selected, the spectrum is displayed.
Set the wavelength range referring to the spectrum.

※When using line sequential,
different wavelength ranges must be set for each detector.

For example, when channel S is set from 400 nm to 500 nm, 
channel 2 can not be set to 500 nm or less. (Look at internal image)

There is no restriction on the frame sequential.
To set the frame sequential, change the ‘Switch track every’ item to ‘Frame’.

Internal image
When line sequential is used, this position is fixed.

ChS or Ch2

range

ChS

Ch2
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LSM780 Simple manual [for Incubator]
<Panasonic CO 2 Incubator operation method>

Press SET twice.
Press the horizontal triangle key and the upper triangular key to set Co2 to 5%.
Press ENT twice.
(Leave incubator for about 1 hour to stabilize)

If using an incubator, turn on the Temp Module S and CO2 Module before turning on the laser microscope.
<How to operate incubator for microscope>

Replace the stage holder with a heating insert.
Attach an orange dummy cap.
Lid the heating insert.
Add sterile water to the bubbler and cap it.
Open the secondary pressure valve of the CO 2 cylinder. (Do not change pressure)
Turn on Temp Module S and CO2 Module. (It is normally ON)
Turn on the main switch and the COMPONENT switch of the centralized power supply.
Set the CO2 concentration and temperature by the following method.

Operate the touchscreen of the microscope.
Touch ‘Microscope’ - ‘Incubation’.
Touch ‘H Insert P’ on the Incubation tab.
Set the temperature and change the control to ON. Touch OK.
Set Inc PM, H Dev, CO 2 in the same way.

(Leave incubator for about 1 hour to stabilize)

<Operation at image acquisition>
Adjust the adapter size when using a 35 mm dish. (Tighten the screws to fix the width)
Remove the orange dummy cap. Attach the adapter. (60 mm dish requires no adapter)
Place the dish and observe it.

<After use>
Stop the incubator with the following method.

Operate the touchscreen of the microscope.
Touch ‘Microscope’ - ‘Incubation’.
Touch ‘H Insert P’ on the Incubation tab.
Change the control to OFF. Touch OK.
Set Inc PM, H Dev, CO 2 in the same way.

Close the secondary pressure valve of the CO 2 cylinder.
Shut down the laser microscope.
Discard the water from the bubbler. Remove the cap and dry the bubbler.
Replace the heating insert with a stage holder.

<Operation after using Panasonic CO 2 incubator>
Press SET twice.
Press the horizontal triangle key and the upper triangular key to set Co2 to 0%.
Press ENT twice.

Write in the records of the incubator.

Heating insert
Bubbler

Dishes of 60 mm and 35 mm can be used.

Panasonic CO 2 Incubator is for the sample that is waiting.
If you do not need an incubator, operation is unnecessary.
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How to put the immersion medium (oil , water)
Use the coordinate registration function of the microscope and register the observation position on the Pos 1 button.
(When repeating the same work, it is convenient to register the open position at pos 2.)
When moving the stage, using a low magnification objective lens will move faster.

Find the target place with dry objective lenses.
Operate the touch panel. (Microscope) , XYZ , Save Position , Pos1
Coordinates are displayed on the button of Pos1. (Coordinates have been registered.)
Move the stage to the open position. (Use 5x lens for movement)
Change the objective lens using the touch panel. (Microscope) , Control , target lens
Put the immersion medium on the lens.
Tap [Back] on the touch panel. (Change to dry lens)
Operate the touch panel to move to the observation position. (Microscope) , XYZ , Pos1
(Microscope) , Control , target lens
When the objective lens changes, tap Done on the touch panel.
Adjust the focus.

※When returning from immersion to dry lens, wipe off the immersion medium of slide glass.
※Save Pos1 again if the observation position changes.
※The registered information disappears when the microscope is turned off.
※If the immersion medium and the mounting medium are mixed, it will not be in focus.
If you can not see in the middle of the observation, wipe off the immersion medium and put it again.

Slide glass

Objective

Immersion
medium

Move stage and change lens. 
Put on immersion medium.

Slide glass

Objective

Register the observation position in Pos1

Slide glass

Objective

Move to Pos 1 with dry lens.
Change the lens just below the sample.

Diopter adjustment
Align the focus position of the observer with the focus position of the laser microscope.

Scan the sample and focus with the laser microscope.
Click “Locate” button to switch to observation mode.
Set the microscope setting so that you can observe the image taken by laser microscope.
Do not touch the focus and do the following.
Look through the right eyepiece with your right eye. Turn the right diopter adjustment ring to focus.
Look through the left eyepiece with your left eye. Turn the left diopter adjustment ring to focus.
Look with both eyes and check that the subject is in focus.

diopter adjustment ring 

How to set the tiling range visually
I will show you how to set tiling range by visual observation.

Click “Acquisition” button to set it to laser microscope mode.
Set to scan with a laser microscope.
Check "Tile Scan".
Pull out (drag the title bar) the Tile Scan bar at the bottom of the window.
Select “Bounding grid”. Set Overlap to 10.
Check “Online stitching” and set Threshold to 0.7.
Click “Locate” button to switch to observation mode.
Find the end point of the range you want to capture in a state where it can be observed.
(For example, the yellow frame part of the figure.)
Move the end point to the center and click “Add” button in the Tile Scan window.
Move to another endpoint and register with “Add”.
Once all points have been registered, click on Acquisition to switch to laser microscope mode.
Display the image with Live Scan, and adjust the brightness and focus.
Start Tile Scan with “Start Experiment” button.

Drag the “Tile Scan” bar

Reference image: 
Circle is the visual field.
Square is zoom 1x scan range.

appendix
Activate the stage button
and click in the image to move the stage
to that location.
(You can also use tile scan images)

End points

Tile Scan range



2019.06.11 Central Reseach Laboratory,
Okayama University Medical School 

Specification list of LSM780
microscope： Inverted microscope AxioObserver.Z1

Objective
Grade Mag Medium NA WD Code DIC Code

Plan Apochromat 10 Air 0.45 2.1 420640-9900-000 Ⅱ 000000-1045-073
Plan Apochromat 20 Air 0.8 0.55 420650-9901-000 Ⅱ 426940-0000-000
Plan Apochromat 40 Air 0.95 0.25 420660-9970-000 Ⅲ 426944-0000-000
C-Apochromat 63 Water 1.2 0.28 421787-9970-000 Ⅲ 426946-0000-000
Plan Apochromat 63 Oil 1.4 0.19 420782-9900-799(000) Ⅲ 426957-0000-000
Plan Apochromat 5 Air 0.16 12.1 420630-9900-000 -
APO Kalibrierobjekti Air 420639-9000-700

Filter set
Band No. Name Ex DM Em Code
UV 49 DAPI G365 FT395 BP445/50 (420-470) 488049-9901-000
B 38 GFP BP470/40 (450-490) FT495 BP525/50 (500-550) 000000-1031-346
G 43 DsRed BP545/25 (533-558) FT570 BP605/70 (570-640) 000000-1114-101
B 16 AF488 BP485/20 (475-495) FT510 LP515 488016-9901-000

Detector
Name Type Range Resolution
Ch1 PMT 371-740nm 1nm

ChS 32chGaAsP-PMT 410-694nm
Highest 3nm
Normal 8.7nm

Ch2 Cooled PMT 379-758nm 1nm

Laser
Name Power Life Wavelength
Diode 30mW 5000h 405
Ar 25mW 5000h 488,458,514
DPSS 20mW 5000h 561
HeNe 2mW 594
HeNe 5mW 10000h 633

Beam splitter list
MBS 458 Plate
MBS 458/514 MBS 355/445
MBS 458/561 MBS -405
MBS 458/514/594 MBS -445
MBS 488 MBS 690+
MBS 488/561 MBS 760+
MBS 488/594 MBS -405/760+
MBS 488/561/633 MBS -445/760+
T80/R20 T80/R20
Plate None

Lamp
Name Power Life Code
Metal halide 120W 1500h 000000-1313-162
Fiber 1.5m 3year 000000-1313-164
halogen 12V100W 2000h 000000-0518-961

Medium

Name
Refractive

 index Capacity Code
Immersion oil 1.518 20ml 444960-0000-000
Immersion water 1.3339 20ml 444969-0000-000
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